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Version 14.0 Update Supplement 

Installing the New Version of Pulsonix 

It is always recommended you back-up all libraries, designs, Technology Files, Profile Files and 

Report Maker Format Files before installing the latest version. Other than for any technical reason, 

this is good working practice, although you should already have a backup of this data! 

To install Pulsonix, double-click on the download executable and wait for a short time. Follow the on-

screen commands from the install wizard. The wizard is made up of tabbed pages of a dialog, each 

one has a different topic and should be reviewed. Some need additional information from you and 

your choices entered. 

By default, a folder name of the current version is offered, it is recommended you use this. There is 

no advantage or disadvantage in installing Pulsonix over the top of the existing version. 

If you prefer, you can uninstall the old version once the new version is running satisfactorily. 

Installation Folder 

By default, Pulsonix will be installed into the 64-bit programs folder C:\Program Files\Pulsonix14.0 

and not C:\Program Files (X86).  

Documentation Installation 

The default installation locates all Pulsonix ‘documents’ (Master Libraries, Technology files etc.) 

under user\documents\Pulsonix14\ 

Customise Feature Installation 

During a new installation, you can now customise the features that are installed with Pulsonix. 

Currently, there are 4 required features which cannot be deselected, these are listed at the top of the 

list. The remainder of the features can be deselected so that they are not installed based on your 

preference and requirements. You can customise the installed features in first-time installation mode 

and Repair mode (selected from Settings on your Windows Start menu). 
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Repair or Uninstall 

If you already have Pulsonix 14 installed and run the installer again, you will be instructed to run the 

add/repair option selected from Settings on your Windows Start menu. 
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From there, you can Repair or Uninstall the product using the options presented: 

 

When Next is pressed, you can now choose the features to install or reinstall if deleted. 

 

Licensing 

Version 14.0 requires a new licence if you are a new user or upgrading from any older version of 

Pulsonix earlier than and including V13.0. The new licence would have been supplied to you under 

the terms of your maintenance contract or product purchase. 

For existing users upgrading from a previous version, it is recommended that you save the new 

licence in the same location as the current one but make a backup copy first or rename it. When 

requested during installation, simply click the No Change In Licensing check box on the licensing 

page of the installation wizard. The License Manager can be used to add new licences and make 

changes to network licensing after the installation has been completed. 
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Version 14.0 Network Licence Server (NLS) 

NLS has been updated for Version 14.0 but an existing NLS installation of V13.0 will still run 

V14.0. However, in order to access any new functionality and to take advantage of any issues fixed, 

you should always install the new version of the NLS program. Older versions (prior to V13.0) will 

not run V14.0 Pulsonix and cannot be supported. 
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New In Version 14.0 

Help Now Optionally Web Based 

The online help system is now available on your web browser. This is the default mode when you 

first install Pulsonix 14.If you prefer to use the local .chm help file then you can switch back to this 

using the Options dialog and General page. Uncheck the Use Web Help option:  

  

Tear-off Windows – Use of Dock Bars 

Torn-off frames now have the ability to use dockable bars, for example, Find, ERC Errors bar etc. 

However, the Database Connection (PDC) bar is not available on a torn-off frame, but all other dock 

bars can be used. If the PDC is required, then it can be used in the main Pulsonix window and 

components directed to the torn-off window in use. 

The docking state of each dock bar is copied from the main frame each time a new torn-off frame is 

created. The docking state is not remembered on restart if it is changed in a torn-off frame. 

Dock bars cannot be moved/undocked/floated on a torn-off frame. 

Customise - Commands Filter 

In the Customise dialog, a new Filter section has been added to the Commands page. This allows 

commands that contain the filter string or are available with the selected design context to be shown. 

The filtered commands are updated every key press or when the context is changed in the selection 

box. 
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Synchronise - Design Changes 

When the Synchronise Design option is run, the option, Components will be removed has been 

changed to Changes could remove tracks, and a sub-option Remove connected segments has been 

added. 

The improved functionality can now detect pad changes so you can choose if you want to Keep 

Tracks or just remove the connected segments. 

 

This feature was back-fitted to V13.0. 

User Information for a currently Open Design 

When a design is opened with write access, a lock file is created containing some details about the 

user who had opened the design. When attempting to open the same design in Version 14, the lock 

file is read and the computer name and user name of the person who has the design open is reported 

as a warning message. 

This only applies to Schematic and PCB designs. 

 

A note about lock files – if a lock file remains after closing and the design is not open, the lock file 

can be safely removed without any detrimental effect on the design it is related to. 

Disable Variant Attributes 

From within the Design Properties, you can now Edit the attribute value in the <Master Design> 

column even if the Variants field is disabled in the Technology Attribute Naming dialog. 
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This feature is also available when using the Inspector Bar. 

This feature was back-fitted to V13.0. 

Component Variant Spreadsheet – ‘Reset To Defaults’ Cell Colours 

A Reset to Defaults button has been added to the Component Variant Spreadsheet which, when 

clicked, sets cell colours back to their original ‘factory’ values. The original colours will depend on 

which theme is currently active (for example, if light theme is active, the light set of original cell 

colours will be used). 
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Library Manager 

Find Dialog Changes 

In the Library Manager dialog after using the Find option on Parts or PCB Footprints, you can now 

multi-select items and edit them with the new Edit button. 

 

The find PCB Footprints dialog has a new Edit button and allows multiple item selection: 
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Part Edit / Edit Attributes – Validation String 

In the Part Edit and Edit Attribute dialogs, if you select an attribute value that has a validation 

string (defined in the Technology dialog under Attribute Names), a drop down list will appear with 

available attribute values that are based on the validation string (only a simple OR wildcard is 

supported otherwise the string won’t appear in the combo box list).  

example 1: 

validation string : Test1 | Test2 

list : {Test1, Test2} 

 

example 2:  

validation string : *Test1 | Test2 (‘*’ is a wild card) 

list : {Test2} 

 

Properties - Edit Rules  

Error Marker Properties 

There is now an Edit Rule button available on the Properties dialog for an error marker. It is 

enabled if a rule name is displayed for the reason for the error. Not all errors have a rule displayed. 

 

Pressing the button will apply the Property page, quit the dialog and run up the corresponding rule 

page in the Technology, with the appropriate rule selected. 

Property Pages with Relevant Rules 

This functionality has also been provided for Property pages that list relevant rules. For example, 

Differential Pair, Net and Area.  
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To use this, select a rule in the list and Edit Rule will be enabled.  

 

Edit Rule in Measure tool 

The Edit Rule Button is also available in the Measure dialog.  

 

This is enabled if a rule is displayed in the Gap page of the dialog showing the rule responsible for the 

displayed spacing. Again, pressing the button will quit the measure dialog and run up the correct rule 

page in the technology, with the correct rule selected. 

Property Sheet Search Bar 

The Property Sheet Search Bar is enabled on property sheets with a tree control, within the 

Technology and Options dialogs. 

By typing into the search bar, you will be presented with results that match the words. Selecting a 

topic presented will direct you to that page. 
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The Options dialog also has the search facility: 

 

Find in Grids 

From with any dialog grid, such as Technology and Nets, you can now use the standard find 

command Ctrl-F when the grid has focus. 

A dialog is displayed from where you can type in the string you wish to find. 

 

Settings are saved when a find is performed, by pressing the ‘Find Next’ button. 
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These saved settings will be used when the find window is next opened. 

The position of the find window is saved when it is closed so it will open in the same location. 

There are options that can be changed in the find window that will affect if and how a match is found 

in the grid: 

Find what – This is the string that will be searched for in the grid 

Match entire cell contents – Find will return a match only if the find string matches the entire 

contents of a cell 

Match whole word only – Find will return a match only if the find string matches whole words in the 

contents of a cell. Note: This option will have no effect if ‘Match entire cell contents’ is checked 

Match case – Makes the find case-sensitive 

Search 

By Rows – Specifies the search order by rows. The whole of a row will be searched until moving on 

to the next row 

By Columns - Specifies the search order by columns. The whole of a column will be searched until 

moving on to the next column 

Direction – The direction options shown are determined by the selected Search option 

By Rows 

Up – The search direction will be from right to left for each visible row from bottom to top 

Down – The search direction will be from left to right for each visible row from top to bottom 

By Columns 

Left – The search direction will be from bottom to top for each visible column from right to left 

Right – The search direction will be from top to bottom for each visible column from left to right 

Find – Find Nets In Busses Option 

With a Schematic design, within the Find dialog and Nets, there is now a new Find Nets In Busses 

option. 

If checked it will first find the subnets of the chosen net, and then find each bus that contains the 

chosen net. If unchecked, only the subnets will be found and not the actual bus. 
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When finding nets in a schematic design the Find Bar context menu will also contain the this option. 

 

Find Net Command – Updated Functionality 

The Find Net command now finds the net of a selected item in the design.  

The existing Find Net command is available from the Edit Menu. It is now also available from the 

context menu in the main window when an item on a single net is selected. 

Using this feature 

When selected, it first switches to the Nets find category (as it used to), and then finds the selected net 

if it is in the find bar list. So if you are using a Nets filter and the net does not match it then it will not 

be found. 

In the PCB or Footprint editors the whole net will be found and displayed using the current Find 

options. 

In the Schematic editor the section of the net containing the selected item will be found and displayed 

using the current Find options. You can then use the Find Net Item and Find Previous Item  

commands (or Find Bar buttons) to find the next section of the net. 

Fast Category Switching in Parts Browser 

The Parts Browser has a new pane that can be used to change the Part Category for Parts displayed 

in the tree.  

Where you have multiple named Categories, you can easily and quickly switch these within the Parts 

Browser window by selecting them by name: 
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The Part Browser then displays the named categories ready for selection: 

 

ERC Changes 

Treat All Dangling Connections As Unfinished Option 

There is a new option in the Online ERC Options page, Treat All Dangling Connections As 

Unfinished. When selected, this option causes a connection to be marked as unfinished (i.e. drawn in 

the unfinished colour) if the connection ends on nothing at one of its ends, even if it is labelled with 

the Net Name. The default for this switch is unchecked. 

This was added for users who want all dangling Schematic connections to be shown as unfinished. 

Normally, the presence of a Net Name or Signal Reference means it is not unfinished. 
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This feature was back-fitted to V13.0. 

Split Net Check Change 

For the ERC split net check, the Unless ungated pin is PCB No Connect wording has been changed 

to Unless Pin Type is not PCB Connect to reflect the actual functionality being performed. 

 

This feature was back-fitted to V13.0. 

Alternative Error Marker Symbol 

An Error Marker will now show an alternative symbol for Errors that have Notes assigned to them. 

Instead of the normal origin style symbol, a document style symbol is displayed. This does not affect 

an Error Marker that shows a line between two items rather than a symbol. This is available for both 

Schematic and PCB designs. 

 

Allow Moved Names on Locked Components 

The select mode context menu items Allow move of Name attribute on Locked Items and Don’t 

Allow move of Name attribute on Locked Items have been replaced by a checked menu item Allow 

Move Names on Locked Components. 
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Changes to Schematic RINF PCB Netlist Export Format 

The RINF netlist format exported from a schematic design has been changed to include all component 

attributes in the .COM_ATT lines. The attribute names must be the All Designs context to be 

included in the export. 

This feature was back-fitted to V13.0. 

Changes to the Select Mode context menu 

In order to rationalise the length of the Select context menu, there have been some additions to the 

main menu with some of the options being grouped into sub-options. This change affects options such 

as Select Component, Select Track, Select Shape etc. 

 

Added new Move sub menu 

Added new Rotate sub menu 

Added new Mirror sub menu 

Added new Mitre / Fillet sub menu 

Moved Enable Selection Mask option onto Select sub menu 

 

Technology Changes 

Circular Hatching Style 

A new Hatching Style has been added to the Technology dialog.  

In addition to lines, you can now opt to draw the shape filled with circular cutouts.  

Additional controls have been added to the Hatch Style dialog to define the Line, Width % and 

whether it is Cross Hatched or not, and the new controls for Circles. A circle Radius is required for 

this setting. 
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Hatch Style Naming Rules 

The Hatch Style Naming Rules dialog has also bee updated to accommodate this new style. 

 

You can set the naming rule to be Is circular which checks the styling in the Hatch Style name; it 

checks if the style is Lines or Circles. 

A new Field of Radius is available along with a Pre-text of r=  This reports the radius of the Circle 

defined for the Hatch Style. 

Resultant Copper Hatch Styling 

Once the rule is applied to a copper shape, it looks something like this: 
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Differential Pairs – View Chain Option 

A new View Chain button has been added to the Differential Pairs page of the Technology.  

 

This feature allows you to view a detailed representation of the whole Differential Pair Chain. 

 

Each Differential Pair in the chain is displayed side by side, providing a comprehensive view of the 

entire chain structure. 

The drop-down box enables you to select and view the different Chains available. 

Differential Pairs - Report 

A Report button has been added to the Differential Pairs page of the Technology dialog. This 

reports information about the defined rules of the selected item or multiple selected items. 
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Find from Differential Pairs Dialog 

In the Technology dialog and Differential Pairs page, there is now a new Find button. Pressing the 

find button after selecting a Differential Pair name from the grid will highlight the selected path in the 

design. 

  

Find will use the standard Find options for dimming etc. 

 

This feature was back-fitted to V13.0. 
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Find from Signal Paths Dialog 

In the Technology dialog and Signal Paths page, there is now a new Find button. Pressing the find 

button after selecting a Signal Path name from the grid will highlight the selected path in the design. 

 

This feature was back-fitted to V13.0. 

Check Spacing Values Net Pre-selection 

If two nets are selected in the design, when you open the Technology and Spacing Rules page and  

Check Spacing Values, the two net names will now be pre-selected in the dialog. Also, if both items 

are on the same layer (in a PCB design), the Layer control is also set in the dialog. 
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Same Net Drill Spacing Values for Plated Drills 

In the Technology under the Design Level Spacing Rules and Drill tab, there is a new control for 

Same Net. This enables you to set the spacing value for two plated drills on the same net. 

 

Net Class Level – Name Colour Coding 

In the Technology under the Net Class Level Spacing Rules, Net Class items in the list change 

colour based on the spacing values. This is similar to the colour coding for Spacing grids - Black for 

inherited Design Level, Green for minimum spacings, Blue for explicit values and Red for both 

(green and blue). 

 

Back Drilling – Inner Start Layer 

From within the Technology dialog and Back Drill Layer Span page, the Start Layer option for a 

back drill span has been updated to allow the selection of an inner electrical layer (or inner reference 

layer). This enables back drill spans to be used on vias that do not start on either <Top Side> or 

<Bottom Side>. 
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This feature was back-fitted to V13.0. 

Layer Materials – Density field 

You can now specify the Density of a material in the Materials dialog. This field will be exported 

from the Report Maker option. The value used is defined in g/cm3 

 

Load Technology 

Ignore Design Level Attributes for Symbols option 

There is a new option in Load Technology dialog – Ignore Design Level Attributes for Symbols.  

 

If checked and you are loading the Technology into a Symbol, Design Level Attributes will be 

removed from the list. This enables you to add design level attributes to a Technology file and avoid 

having them added to a footprint or Symbol when loading the Technology file into them. 

This feature was back-fitted to V13.0. 
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Named Acceptance Rule Sets Listed for Save/Loading Technology Files 

When Loading or Saving Technology Files, you can now select any DRC Named Rule Sets that 

have been saved. 

 

Copper Pour – Only remove Isolated Islands that are too small 

There has been a change to the way touching copper items are handled when considering islands. 

From the Technology under Rules – DFM/DFT and Copper Pour, the column Min Island Size has 

been moved to the isolated islands section to reflect the code change. 

 

If you have Keep Touching Copper checked, then items of copper that touch another item of copper 

will be counted as connected; this means the minimum island size doesn’t apply to them, (the 

touching items of copper are effectively the same item of copper). 

As an example, with Keep Touching Copper not selected, it produces this result: 
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With Keep Touching Copper selected, it produces this result. One of the four copper quadrants is 

selected in the design to highlight the result: 

 

Options Dialog Changes 

Weld Spot Shape 

In the Options dialog under Move, using the Show Weld Spots check box, you can set the shape of 

the spots using the drop down list. There are three options available for the shape: Circle, Octagon 

and Square. The shape is defaulted to circle. 

 

The example below shows a Square weld spot shape: 
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Weld Spot Size 

In the Options dialog under Move, using the Show Weld Spots check box, you can now supply a 

size to draw the spots. If you set it to zero it will use the default size that was used previously. This 

was the default junction size in a Schematic design and 28 Thou (0.7112mm) in PCB. 

 

Simplified Display dialog in Options 

The Options dialog and Display page have been reorganised and simplified by removing redundant 

drawing options such as Fast Redraw and Use for Dynamic Items. 

 

3D Viewer Changes 

STEP 3D Viewer Performance Improvements 

There are large performance improvements across generation and output of the STEP 3D Viewer due 

to more efficient utilisation of multi-threading resources. This results in improvements of an up to 

80% faster generation time. On average, an improvement of 50% has been seen, with larger designs 

seeing much larger improvements. 

Calculation of flexi board folding has been significantly improved, also utilising multi-threading 

resources. Greater performance improvements can be seen with higher levels of fold animation. 

STEP 3D Exploded View Performance Improvements 

The performance of Exploded View generation in the STEP 3D viewer has been improved. Up to 

90% increase in generation speed can be experienced with larger designs, with an average of 72% 

seen. 
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STEP Hierarchy Bar 

Within the 3D Viewer, there is now a STEP Hierarchy Bar. This bar contains a tree that is populated 

with the internal document structure of a design in the STEP 3D Viewer.  

 

This bar allows you to view all items currently in the scene, and enables the following functionality: 

Selection – selecting an item in the tree will select the corresponding item in the 3d viewer, and vice 

versa. 

Toggle Item Visibility – Context menu option with an item selected in the tree. This allows the user to 

selectively show/hide single items within the scene. Hidden items will still be output to STEP, as they 

still exist in the internal document structure, but will not be seen in the viewer itself. Hidden items 

will show in the tree with a dimmed text colour, so the user can differentiate between shown and 

hidden items. 

View Extents – Context menu option with an item selected in the tree. This option will fit the view to 

show the bounds of the selected item in the 3D viewer, which allows users to easily find specific 

items. 

Change Variant in 3D Viewer 

Can now change variant in the 3D Viewer using the Change Variant option from the 3D Design 

menu.  

 

Changing the variant will update component shape, component footprint shapes, component areas, 

text and callouts within the 3D viewer. This removes the need to regenerate the entire scene to switch 

variants.  

If the 3D design is open, changing variant within the PCB design will also update the 3D to reflect the 

changes. 
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Flexi Bend Region – Lift-off State 

Flexi bend regions can now have a Lift-off state applied to them, this is set in Bend Line Properties. 

This will alter which transform is applied to a Rigid Moving Board that has bend lines within the 

board outline. 

Lift-off means the flexi portion of the board can start within a existing board boundary and not exit 

through the ‘edge’ of the board. 

 

Flexi bend regions can now be placed on a flexi board within another board outline, if the flexi board 

lies on <Top Side> or <Bottom Side>.  

There is an Enable Lift-off check box for a flexi bend line, which can be set in Bend Line 

Properties. 

 

Enable Lift-off – With this selected, the bend will lift-off the surface of the Rigid Board. The 

transform applied to a rigid board will be the same as the 'Bend' shape for this flexi board bend. 

Below are some examples of what is now possible with this feature: 
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Interactive Clipping Plane 

New Clip Plane options have been added to the 3D Design menu for the 3D Viewer.  

A Clip Plane is a visualisation option that allows areas of the design to be selectively disabled from 

view enabling you to focus on areas of interest. 

 

The clipping would look like this: 



34   Pulsonix Version 14.0 Update Notes 

 

Options allow a clip plane to be added normal to the X axis, Y axis and/or Z axis, and allows 

interactive repositioning of the planes along their respective normal. You can use more than one plane 

view at any time. 

The Reverse Normals option is used to reverse the X, Y or Z clip plane views by 180 degrees  in the 

3D Viewer. 

Once in this mode, you can drag the view using the interaction arrow. 

To remove any Clip Planes from view, from the 3D Design menu and Clip Plane> option, deselect 

the option to do not wish to view. 

When using clip planes, they will automatically disable ray tracing in the 3D Viewer as this options is 

not supported. It will automatically reenable ray tracing if you remove all clip planes. 

Clip Plane Colour 

A Clip Plane colour has been added to the grid on the 3D Settings Colour page, along with the option 

to enable transparency and the transparency value. 
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Type Coord and Type Offset in 3D Viewer 

The Type Coordinate and Type Offset options can now be used in the 3D Viewer. These options 

have been added to the 3D Design menu under the Move > option.  

 

An item in the viewer must be selected for the options to be available for use, these will be disabled if 

no item is selected. 3D objects can only be moved in the X,Y plane. 

Generate Height from STEP for Selected Components 

When using the Generate Heights from the 3D Design menu with items selected, a warning message 

will appear asking if you would like to generate heights for only selected components.  

 

If you click yes, only the selected components will have their heights generated from their STEP 

models. If you click no, Generate Heights from STEP will proceed as normal, generating all heights 

in the design. 
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3D Settings – Dialog Reorganisation 

The 3D Settings, Settings page has been reorganised to group the Advanced Settings into more 

logical groups. Other selective options have also been moved on the dialog.  

  

Component Model Selection for 3D Viewer 

The No Components check box on 3D Settings dialog has been changed to a Components section. 

This now has three radio buttons - All, STEP Models Only and None. 

 

All will generate all the components as normal. 

None will not generate any components.  

STEP Models Only will only generate components with valid STEP models, and so will not use any 

3D package definitions, or create a default package definition if one can’t be found. 
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Note: Normal usage would be for each component to be exported using its associated STEP model, if 

one isn’t available then it uses the 3D Package definition. If this isn't available, it uses the 

Component Height attribute. Finally, if this isn’t available, it then uses a built-in system value of 2mm 

for the component height extents. 

New Area Colours 

The Area colour in the Colours grid in 3D Settings has been split into two different colour selections 

for Area and Component Area. This allows you to differentiate between the two area types within 

the 3D viewer.  

Area and Component Area colours can now have a transparency.  

Note: to show areas in the same way as in previous versions, you can set transparency enabled with 

an opacity at 0 (meaning fully transparent) - this will show a wireframe-like version of the area. 

 

To facilitate clash detection for areas, they can no longer be drawn as a wireframe. This is because 

clash detection requires triangulation, which is not calculated of wireframe shapes. 

New Display Mode selection 

The Is Solid check box on the 3D Settings Colours page has been changed to a Display Mode list 

box with three modes available. 
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The previous, Is Solid, option allowed changing the display mode of the viewer between Shaded and 

Wireframe modes. 

The Display Mode list contains both Wireframe and Shaded modes, but also Shaded With Edges 

mode. This mode is essentially Wireframe and Shaded modes combined – displaying the shapes as 

shaded, but with face boundary drawing enabled. 

When changing display modes, it will no longer require a full regeneration of the 3D Viewer, and will 

change the display mode for all shapes in the scene on-the-fly. 

Wireframe only displays like this: 

 

Shaded with Edges displays like this: 

 

Shaded displays like this: 
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Single Entity Merge – Preserve Colours 

A Preserve Colours option has been added to the Single Entity Merge section on the 3D Settings 

Output page. Enabling this option will retain the colours of the shapes in the scene when merging 

them into a single entity. 

 

Note: This has been added as a separate option because the merge process needs to be less destructive 

to be able to map colours correctly. With Preserve Colours enabled, the file will be slightly more 

complex (includes colour definitions and more complex geometry definitions). With Preserve Colours 

disabled, the geometry can be simplified further, resulting in a slightly smaller file size. 

New Measure and Clash Marker Colours 

The 3D Settings Colours page has been changed to add a colour selection for the Measure and 

Clash Marker options. These colours will also be used within the 3D Viewer and Position STEP 

Model options. 
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Component Keep Out Clash Detection 

A new Component To Area option has been added to the Clash Detection section of the 3D 

Settings, Interaction page. This will enable clash detection between components and component 

keep out areas. 

 

For an area, if no height is defined, components models clashing with the area at all will be classed as 

a clash. If a keepout height is defined (If Higher Than selection in Area Properties), a clash will be 

found if the component is clashing with the area but only if the component is taller than the defined 

area. 

Changes to 3DIgnoreClash STEP Attribute 

The 3DIgnoreClash user attribute has been replaced with an in-built Part attribute <STEP Ignore 

Clash>. Using a built-in attribute means you can add it to a Component using Properties and select 

it from the drop down list. 

Any existing designs that used the old method are converted to use the new attribute when opened 

and subsequently saved also when the design is saved. 

New <STEP Suppress> Attribute 

A new <STEP Suppress> attribute has been added, this can be added to a component. A component 

with this attribute will not be generated in the 3D Viewer or output. 

This allows you to selectively suppress components that they do not require, without needing to use 

an empty <STEP Filename> attribute. 

If you use <STEP Filename> attribute (with a filename) and also add the <STEP Suppress> attribute, 

this overrides the <STEP Filename> attribute and suppresses it in the 3D Viewer and the output. 
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STEP Model filter in Position STEP Model dialog 

There is now a Filter section in the Position STEP Model dialog that allows you to apply a filter to 

the STEP Model list to refine it. 

 

Measure option in Position STEP Model 

The Measure option is now available in the Position STEP Model dialog (for Footprints and 

Enclosures) on the Tools drop down menu. 

 

This works exactly the same as Measure in the 3D Viewer. If you wish to select a specific face, use 

the Shift key while making your selection. 

The colour of the measure marker can be changed to your own colour, see below. 

Outputs using Direct2D Drawing 

The Print, Capture Window and Embedded View PDF Output functionality in Pulsonix can now 

use Direct2D drawing technology and so can appear exactly the same visually as when displayed on 

screen, showing such drawing effects as translucency and patterning. 

This is applicable when using Hardware Acceleration levels 3 - 5 (in Options, Display). 
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New command to Rotate Clockwise One Step 

A new command has been added to Rotate one step clockwise. There is no interface change for this 

feature, but it can be assigned to a shortcut key - use the Clockwise Rotation option. 

Apply Vias/Pads – New Options 

New options have been added to the Apply Vias/Pads option to extend its functionality. 

Minimum spacing from existing items inside the shape 

For Fill The Shape option, you can now set the Minimum spacing from existing items.  

  

Spacing from items to shape for Filling the Shape 

Spacing from items to shape is now available for Fill The Shape option. 

 

Connect type 

For the Vias setting, there is now a new Connect Type box that allows you to define the connect type 

of the Vias. Selections are available for Default, Isolated, Not Isolated and Thermal Pad. 

 

Staggered Option in Apply Vias/Pads 

The Staggered option is now available for open shapes when Around Outside option is selected. 

The Apply Vias/Pads option available on the context menu when copper or a track is selected 
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Apply Layout Pattern Apply to Attributes Only 

The new Apply to Attributes Only switch on the Apply Layout Pattern dialog updates the position 

and rotation of common attributes only between matching Components.  

 

Hatch Style Override in Template Properties 

On the Template Properties dialog and Template page, a new Hatch button and Hatch Style box 

have been added. Selecting this will override the Copper Pour rules and use the selected hatch style 

from the list box instead. 
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Track Properties – Display the Layers of Start and End Nodes 

In the Track Properties dialog, in the sections for Start Node and End Node, the layer of each node 

is now displayed, (separated by a -). For example Start In: R15.2 - <Top Side> 

 

Show Only Selection Layer 

A new command has been added to the context menu to Show Only Selection Layer for layer based 

items, such as tracks. It is only available if the item you have selected has a layer and the layer isn't a 

span or a layer set. 

Via Properties – Ability to add Via Attributes 

You can now use the Via Properties dialog to add Via Attributes to a via. You may use this to 

create specific rules for Vias, Spacing rules for example on vias that are used for shielding. 

 

New Cutout Text option 

You can now add stroke, true-type and special text as shape cutouts and merged shapes. 

For example, you can add layer designation to a copper layer: 

 

To use this option 

Select Cutout from the Insert menu. Right click and select Insert Cutout Text. 

Type the text required in the dialog: 



 Pulsonix Version 14.0 Update Notes   45 

 

 

Select the shape you wish to add the text cutout to, select the whole shape. 

Note: You could also start with an unselected shape and select the Insert Cutout Text option first, 

then select the shape to apply it to. 

Position the text and release. 

It should be noted that the Copper Line Style should be a smaller line size so that the text shape can 

be properly cutout as intended. 

Layers Bar – View Layers option 

In the Layers bar, there is a new option to View Layers. This enables you to filter the layer types to 

display in the Layers list. The list box allows you to select between All, Electrical and Non-

electrical. 
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Fillet/Mitre on Corners with an Attached Arc 

You can now use Mitre Corner or Fillet Corner when they are attached to Arcs. These options are 

available from the context menu for a selected corner. 

 

Right click on a corner: 

 

The resultant corner now looks like this: 

 

When using mitre on arc ends, it may result in a mitre of any angle. 

This feature is also available when working interactively within the Edit Mitre option.  

Insert Spiral – Spiral Around Shape 

From with the Insert Spiral dialog, you can select the Around Selected Shape option. This new 

mode enables you to dynamically spiral around shapes for a PCB design or footprint. This can be 

performed for tracks and copper shapes. 
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With this option selected, After pressing OK, the dialog will disappear from view and you will be 

able to hover over items in your design. 

If a suitable shape is available, the cursor will change to show the spiral symbol, otherwise, the cursor 

will turn to an X. A shape is typically invalid for a spiral if it's not closed. 

 

You can change the shape to be Closed using Properties of the selected shape. 

You can also spiral around pre-selected shapes. Select a shape you want to spiral around, and enter 

the Spiral (Tracks or Copper) dialog from the Insert menu. 

Dynamic Snapping when Editing Shapes 

When inserting and editing shapes, it now visually shows you the item that it is snapping to as you 

hover over other shape items. Previously would only snap after placing the shape. 
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The Snapping to Item option is available on the context menu during editing. 

 

Construction Lines - Copy With Offset Dialog Change 

When using Construction Lines, in the Copy With Offset dialog, the label Copies has been 

replaced by Offset, and Steps had been replaced by Number of Copies. These changes make the 

dialog more logical for use. 

 

This feature was back-fitted to V13.0. 

DRC Changes 

DRC Error Bar – Sub-totals of Errors Found 

For each found error category, the error count is now displayed next to the error description. 

 

DRC Named Rules Sets (Acceptance) 

In the DRC/ERC dialogs, there is a new Named Rule Set box list that replaces the Acceptance Rule 

Set. From here, you can now define different rule set names.  

The PCB DRC dialog: 
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The Schematic ERC dialog: 

 

By default, the dialog has the <Acceptance Rule Set> that always appears in the list. This can be used 

or you can also define your own sets for different checking purposes. For example, a set that is used 

for Spacing checking during design, and then a full check at the time of plotting for a full verification 

of the design. 

Once the check box selections you require have been made, to add a new rule set, simply type a new 

name in the entry box and press Save. This and the default set will be saved into the design. 

If you make switch changes and press Save, the currently selected named set will be updated. 

Likewise, a selected named set can be deleted by pressing the Delete button. 

 By changing the string on the combo box and pressing save, a new rule set name is created with the 

current rule checks. The rule set names are saved in the design. 

Load/Save Technology 

The Load/Save Technology options now lists all the available rule set names that are saved in the 

Technology file. 
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Report Maker – ERC/DRC command – Named Sets 

The ability to use a Named Rule Set as an acceptance set within the Report Maker, Electrical Rules 

Check and Design Rules Check commands has been added.  

A named rule set list box has been added to both commands. This will list any existing named rules 

found in the design.  

 

The default named rule set, <acceptance rule set> is used if you do no specify your own rule set. 

ERC/DRC in CAM Plots dialog 

When using Report Maker format files within the CAM Plots dialog, you can use multiple named 

rules sets when using the Report Maker, Electrical Rules Check and Design Rules Check 

commands. 

Online DRC – Check Track Layer Option 

On the Online DRC page of Options, there is now a Track Layer check. 
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When enabled and tracks are not allowed on certain layers (using the Track and Via Size Limit 

Rules), when you change to one of these layers and try and finish the track, it will report a track layer 

error (T-L).  

If you have Continuous Online DRC enabled, you will get the Track Layer error as soon as you pick 

the layer and exit out of the Change Layer dialog. 

This feature was back-fitted to V13.0. 

Improved Precision of Silkscreen Overlap DRC Check 

Silkscreen overlap DRC check previously only checked a bounding box around the text, leading to 

false positive DRC errors, where the text was not actually overlapping the pad. The check will now 

determine if individual text shapes overlap the pad, and so will only produce an error if the text truly 

overlaps the pad. 

The example below shows how a pad sites inside the text bounding box without producing DRC 

errors: 

 

The red area is the invisible text bounding box. The pad clearly sits inside without creating an error. 

This feature was back-fitted to V13.0. 

Apply to Column 

Within the DRC dialog, you can right click on any header of a column and use the Apply to column 

from the context menu. This enables you to apply the current header setting to all options within that 

column. 

 

Odd Angled Track Check 

A new DRC check has been added to detect odd angled tracks (any angle that is not 45 or 90 

degrees). This is available under Nets and Tracks (Odd Angled). 
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When run, if an error is detected, an OAT error marker is added to the design. The error is displayed 

on the start point of any track that has an odd angle. This check is in addition to the Odd Angled 

Track Colour highlighting (see above). 

 

Colours - Highlight Odd Angled Tracks / Connections 

In Colours, Highlights, there is a new colour to Highlight ‘Odd Angled’ Tracks. If the check box 

under Displayed is checked, then any offending tracks will be highlighted if the angle is not 45 or 90 

degrees. 

 

In Schematics, the option is Highlight ‘Odd Angled’ Connections and will highlight connections if 

the angle is not 45 or 90 degrees. 

 

Design Settings – Save default ‘Plot Drilled Out Pad Holes’ status 

You can now set the default status of Plot Drilled Out Pad Holes for use in the CAM Plots option. 

This setting will be saved with the design. The default setting is saved in the Technology under 

Design Settings, General and CAM/Plot. 



 Pulsonix Version 14.0 Update Notes   53 

 

 

This feature was back-fitted to V13.0. 

Interactive HTML BOM Option 

Support has been added for the Interactive HTML BOM option. This tool is a plugin option that 

exports limited Pulsonix design information into a HTML format that produces an interactive design 

and BOM listing that can be viewed and searchable in a web browser. Only the Top and Bottom 

layers are exported and BOM data. No inner layers or attribute details are exported. 

This tool is particularly useful if you are producing boards in-house and hand soldering prototypes. It 

will guide to finding Parts with the same value and their locations. Items selected in the BOM list are 

highlighted in the design view. 

 

Pulsonix automatically generates an input file that is read into the browser ready for use. You must 

have Python installed and configured first though for this to be usable. 

Python 3.8 

The generation of the Interactive BOM requires Python 3.8 (or later) to be installed. 
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You can download the Python installer here https://www.python.org/downloads/  

If you installing Python 3 for the first time, it is recommended that you select the Add python.exe to 

PATH option in the installer, this will allow Pulsonix to automatically locate your installation.     

 

Once successfully installed, the option is ready to run. 

Using the Interactive BOM option 

From the Output menu, select the Interactive BOM option. You are presented with a dialog. 

 

Once configured, pressing OK on the dialog creates a HTML file that is then automatically sent to 

your web browser for viewing. You must have the Open When Complete switch selected on the 

dialog for this to happen. The HTML file saved is self-contained and can be used at a later time or 

given to another person on another machine (provided they have Python 3.8 or later installed). 



 Pulsonix Version 14.0 Update Notes   55 

 

Configure Attributes 

Selecting the Configure Attributes dialog enables you to select the attributes required: 

 

Import Allegro PCB 

If you have the Cadence Allegro Import option enabled in your licence, you can now import files with 

the .alg file extension that have been generated by the Allegro Extracta program. 

The Extracta.exe program is supplied with Allegro but is run outside of their PCB environment but 

still as part of their supplied program suite. Pulsonix calls this program in order to export an ASCII 

file that can then be read in. In this instance, both Allegro and Pulsonix must reside on the same 

machine. 

This new alternative mechanism enables files generated on another machine using the Allegro 

Extracta.exe program to be loaded into Pulsonix. In order to extract the data required there are a 

number of actions required: 

Locate the batch file and associated .txt file supplied with your installed Pulsonix (usually 

C:\Program Files\Pulsonix 14.0\SysUtils\ 

Copy AllegroToPulsonix.bat and the AllegroTranslate.txt control file to the machine that 

has Allegro installed. Copy to an accessible folder (i.e. not the Programs folder containing 

Allegro). For example, create a folder called C:\Temp\ 

Copy the Allegro PCB design file (.brd) that you wish to convert, into the same folder as the 

batch file.  

Launch a Windows command shell (type CMD in the Windows Start menu and press 

<Enter>). 

In the command shell, navigate to the folder that contains the batch file (i.e. cd C:\Temp\ ) 

Run the AllegroToPulsonix.bat using the following command in the command window: 

AllegroToPulsonix design_name.brd <Enter> 
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Note, normal command shell rules apply, for example, if you have spacing in your filename, 

you will need to enclose these in quotes “design name.brd” 

Running the batch file will create an ASCII file of your design with the .alg extension (i.e. 

design_name.alg). 

Copy the resultant .alg file  back to where Pulsonix can read it in. 

In Pulsonix, select the Open dialog on the File menu, there is a new file type. Allegro PCB 

ASCII File (*.alg). Select your .alg design file for import. 

The Pulsonix import filter will now run the Allegro import option. 

External Resources 

If you require an Allegro design in ASCII format, you can provide the AllegroToPulsonix.bat and the 

AllegroTranslate.txt control file to the person performing the extraction. The batch files does not 

require Pulsonix in order to be run. Once run, the resultant .alg file will be provided back to you for 

import. 

Graphical Design and Symbol Comparison 

There are two new modes for design and symbol comparisons: 

The Symbol/Footprint Compare option will compare two symbols together and report or show you 

the differences. Differences can be shown within the dialog or ‘overlaid’ within a new interactive 

comparison mode. The Compare Against option is available from the Tools menu 

The existing Design Revision Analyser has been updated so that the Interactive Mode can be access 

from within the dialog. This option is still available from the Tools menu. 

Symbol Compare 

Run Compare Against from the Tools menu. Works for both Schematic Symbols and PCB 

Footprints. The original symbol would need to be saved as a symbol file for a comparison.  
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Three preview windows are displayed: 

Master – the left-most preview is the symbol currently being edited. 

Compare – the middle preview is the symbol file being compared to; the one defined in the Other 

Symbol to Compare Against entry above it. 

Differences – the right-most preview shows you the differences found of the two symbols. 

Other settings on this dialog enable various facets of the symbol to be compared and displayed and 

for the Preview Settings colours to be defined. 

The Highlight check box enables Items to Cycle Through to be selected. You can choose from 

Areas, Design Attributes, Doc Shapes, None, or Pads. Once an item is selected from the list, the 

Prev, Show and Next buttons will be enabled for use in the preview. 

Interactive Mode 

Once in the interactive mode, both the Master and Compared symbols are displayed. 

 

Mode legend  

A legend is displayed within the symbol design area. This shows you the colour coding for the 

different levels of comparison. 

Added to this version 

From this version 

From last version 

When using the interactive mode, at any time you can right click and from the context menu, options 

are available for use: 

Cancel – selecting this will exit the mode and put you back into the Compare Against dialog. 

Show All Changes – This will display everything that has changed. 

Hide All Changes – This will hide everything that has changed. 
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Report Selected – Hovering over an item in the design shown as a difference will display a small 

modal cursor. It enables you to select the item that has a difference. From here, a report of that item 

can be made. 

Options – This displays options that are available when in this mode: 

 

Design Revision Analyser 

Changes have been made to extend the Design Revision Analyser so that as well as a report, a 

graphical comparison can be displayed using the Interactive Mode button from the dialog. 

 

The Options button enables access to a dialog that allows you to define items that will be used in  

Interactive Mode. 
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As with compare Against, the Design Revision Analyser in Interactive mode displays the 

differences: 
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GenCAD Export 

Neutral Net Names option 

From the Output menu, the GenCAD option has s a new option for Neutral Net Names. When this 

is checked, all user defined net names will output as numerical net names. This helps you protect your 

design IP if sending the file to an external source. 

 

New options to Include Doc Shapes and Text in Export 

From the Output menu, the GenCAD option, there are two new check boxes to Include Doc Shapes 

and Include Text. If selected, doc shapes and text in the design, in components and in doc symbols 

will be output. 

 

Vault Changes 

Using the Vault in V14.0 

In order to access the new Vault features below in Version 14.0, the following changes are required: 

Vault Database version 

For Pulsonix version 14.0, you should update your Vault database to version 1008 using the Vault 

Setup dialog. This dialog will also confirm which version you are currently running. 
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ODBC Driver version 

The V16.0 64-bit ODBC driver is the latest version and will be automatically installed during the 

main Pulsonix product installation. It is not updated if it is already using this version as was installed 

with Pulsonix Version 13. This version of the driver is required on the Pulsonix client side to support 

the Postgres server V14.5.  

Postgres version 

For Pulsonix version 14.0, the PostgresSQL version has not changed and is still 14.5. 

Updated Vault Database (to version 1008) 

For Pulsonix version 14.0, all new or modified functionality listed below requires a new Vault 

Database to be installed. You should update your Vault to version 1008 using the Vault Setup dialog. 

This dialog will also confirm which version you are currently running. 

Before updating, it is highly recommended that you make a backup using the Vault Admin program. 

To update the database, from the Setup menu, select Vault (setup) and Version tab. You must be 

signed in as Admin to update the database. 

The Update Database button will be available for selection. The Latest Version button will display 

1008, showing you that the update is available. 

 

Vault Setup – Visibility of tabs reflects the Sign-in status 

On the Vault Setup dialog, all pages that require a Vault connection are now removed or displayed 

based on sign-in status without the need to reopen the setup dialog. 

Signed out, tabs have been hidden (except Sign In and Users): 

 

Signed in, all tabs are available: 
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Vault Setup – Visibility in Options page reflects the Sign-in status 

On the Vault Setup dialog, the Options page now reflects the sign-in status and hides information 

that would only be visible when signed in. 

 

Spice Models available in Vault 

From within the Vault Manager, you can use the Libraries To Vault option to add the Spice Model 

data type to the Vault. 

The Spice model data type is acceptable to the Vault. As well as Import Vault Libraries and 

Libraries to Vault, a Spice Model can also be checked out or copied out. 
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Format Files available in Vault 

Report Maker Format Files can now be checked into to the Vault using the Format Files to Vault 

page in the Vault Manager dialog.  

 

Once added to the Vault, format files can be managed through the Vault Browser page or directly 

from Report Maker dialog using the new Vault buttons. The Format Files folder and combo boxes 

can now handle Vault virtual folders and format files stored in the Vault. 

Vault Browser – View Text Vault Files 

View functionality is now available for vault text files.  

From the Vault Manager and Browse page, select the text item and press the View button. 

A dialog appears displaying the text in the file. There is also a Save button to save the text file locally. 

 

This feature was back-fitted to V13.0. 
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Vault Audit trail – Filter the Audit Trail on Item ID 

You can now filter the Audit Trail based on a new filter check option Item ID This allows you to 

filter items in the audit trail list based on the item’s ID. 

 

Vault Browser – Synchronise Selected Item 

From the Vault Browser, once Search has been used, you can synchronise the Vault Folders tree to 

the selected item path. Right click on the selected item to choose the new option Synchronise 

Selected Item from the context menu. 

 

Vault Reports – Report Vault Parts without Symbols 

A new report Vault Parts without Symbols is supplied with Pulsonix V14 and is available from the 

Vault Manager, Browser dialog and Reports button. 
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This report will list all Parts in the Vault that only have a PCB Footprint (PCB-Only Part) and Parts 

that only have a Schematic Symbol (Schematic-Only Part).  

This report requires the connected Vault to have Library Referencing enabled. 

 

Recent Notes option in Vault 

Check In, Out and Uncheck notes have been improved, and now are presented in a drop down list.  

This box allows you to select a note that was last used by any Vault type or create a new one. Any 

changes to the note will be saved as a new note template for that Vault type. 
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Vault Browser – Folder Search Filter 

In the Vault Browser Search dialog, you can now filter search results by a virtual folder. There are a 

new set of controls in the dialog to displays all the virtual folders used in the Vault. When entering the 

dialog with no current search settings active, the folder selected in the virtual folder tree on the Vault 

Browser dialog will be pre-selected in the combo box. Alternatively, you can select a different folder. 

You can also optionally include sub-folders of the chosen folder by selecting the Include Sub 

Folders check box. 

 

Type Specific Vault Revision Schemes 

On the Vault Setup page under Revision Naming, you can now apply naming schemes to individual 

Vault item types.  
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This can be done by selecting a Type and a Naming Scheme from the drop down list boxes and 

clicking Add in the New section.  

This will add that applied scheme to the list box in the Vault Item Type section.  

You can also delete applied schemes using the Delete button to the right of the list box.  

When checking in a new item, the revision scheme used will be obtained in the following order: Type 

specific scheme, Class specific scheme then Default scheme depending on the existence of the 

prioritised scheme. 

Vault Browser – Folder Searching 

From the Vault Browser, within the Search dialog, the Folder search now allows two options of 

filtering folders.  

 

The Folder list box displays the last 10 folders used as well as the current folder.  

You can also now use the Browse… button that opens the Browse Virtual Folder dialog enabling 

you can select a folder using the virtual folder tree. 

Vault Attributes in Browser Grid 

From the Vault Manager – Browser page, you can now customise the visibility of columns in the 

items grid. This includes adding new columns from a list of attributes associated with the Vault.  

Opening the context menu by right clicking a column header: 
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This provides you with two options: 

Manage Columns… - This opens the Column Visibility dialog where you can set the visibility of all 

columns. 

Hide Column – This will hide the column where the right mouse button was clicked.  

Column Visibility 

Attribute Visibility Grid 

The grid will show all the attributes that can be added the Vault Browser item grid. Attributes can be 

added using the Attributes page in the Vault Setup dialog. A tick in the check box next to the 

corresponding attribute indicates that this attribute should be visible. 

 

Controls 

Check All - Will set the visibility of all attributes to true.  

Uncheck All - Will set the visibility of all attributes to false.  

Default - Will set the visibility of user attributes to false. 

Vault Audit Trail Define CSV Separator For Report 

From the Vault Manager – Audit Trail page, when exporting a CSV Report, a new dialog is shown 

that allows you to specify the CSV separator character. This works in the same fashion as the 

Attribute Editor CSV Export option. 

 

Once the character is chosen and OK pressed, the report is written. 

This feature was partially backfitted to V13.0. However, the dialog is not shown, but the CSV 

character can be set via the Attribute Editor CSV export. 

Import Vault Users from CSV 

You can now import users into the Vault from a CSV file such as a Windows Account list.  

From the Users page of the Vault Setup dialog, there is a new button, Import.  
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When selected, this will open the Import Users dialog. 

 

On this dialog, you can browse for the CSV file using the Browse… button. Once opened, the dialog 

grid will populate with the contents of the CSV file plus an extra column Member Of, which allows 

you to specify which Vault group the user should belong to. Using the selection in the User Details 

section, you can specify which column of the grid corresponds to the user’s name and description.  

You can specify a password that is used for all the new users. Hard coded text can be added in 

addition to some built in tags (inserted by the right arrow button to the right of the password control) 

that allow for unique generation of characters.  

The controls in the Username Space Settings can be used to control how spaces in the imported 

names are to be handled. 

When ‘OK’ is pressed, the dialog will close and a report will be generated allowing you to review 

your changes before it is applied to the Vault. The report also shows you the passwords that will be 

applied to each user. Confirm changes by pressing Yes on the confirmation message box. 
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Vault Browser Shows Design Previews 

The Vault Browser will now show previews of design-based Vault items such as PCB and Schematic 

designs.  

 

For performance purposes, the preview uses a thumbnail image to avoid the need to fully draw the 

design each time it is selected in the browser. The thumbnail image is generated on first use and 

stored with the Vault data files. 

In the Vault Setup, Options dialog under Personal Settings there is a new option Show Design 

Preview in Browser option. By unchecking this option you can stop these previews from being 

shown which may be useful when you are accessing the Vault over a relatively slow connection such 

as a VPN.  
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Update Vault Cross-References Progress Dialog 

The Update Vault Cross-References dialog (available from the context menu) now displays a 

progress dialog when Update is pressed. The progress dialog displays the name of each part that it’s 

updating.  

You can access this dialog through the Vault Manager dialog by right clicking on a PCB Footprint 

or Schematic Symbol from the item grid and selecting Update References to Selected Item. 

 

Pulsonix Database Connection (PDC) Option 

Database Check and Update - Select Part dialog 

When using the Database Check and Update option from the Tools menu, if Update is used, when 

the Select Part dialog is displayed there is now an additional button Info.  

 

Pressing the Info button will display a report of information related to the Part currently being 

checked against the database, for example, Name, Part Name, Footprint, Attributes etc. 
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This feature was back-fitted to V13.0. 

Overriding the Default Database Query Timeout 

By default, all queries sent to the database will time out after a set period to avoid permanently 

blocking Pulsonix, causing it to freeze. This period will vary and will be defined by system 

parameters. Sometimes, particularly a with very large database, the time out period can be too short to 

allow the Database Connection to complete fetching the data it requires. In this case, it is desirable to 

be able to override the default time out period for Pulsonix without affecting the system wide default 

setting. 

To achieve this, it is possible to manually edit the DCC file, using Windows Notepad for example, to 

add a Settings section that defines an alternative query timeout period. The Settings section should be 

added to the end of the DCC file immediately before the closing bracket as shown in the example 

below. For brevity, the detail of other sections is shown as '...'.  

(Pulsonix 

  (HEADER 

    ... 

  ) 

  (Contents  

    ... 

  ) 

  (Mappings 

    ... 

  ) 

  (Exclusions 

    ... 

  ) 

  (Settings 

    (QueryTimeout 45) 

  ) 

)  

 

This feature was back-fitted to V13.0. 
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Report Maker Changes 

Changes to Draw Line command 

The Draw Line command now has two check boxes for Start Column and End Column.  

 

Check the Start Column box to provide the column (as an order where 1 is the first) that the 

horizontal line will start from. Check the End Column box to provide the column that the line will 

draw to the end of. Unchecking either box will draw the line to the table extents. 

For example, this allows you to draw a line under the first two columns only. 

 

Check Out/In of Vault Format Files on Report Maker dialog 

Report Format Format Files can now be added to the Vault. New format files can be added directly 

from the Report Maker dialog using the new Vault buttons on the Report Maker dialog (as well as the 

Vault Manager dialog and Format Files to Vault page). 

If you have the Vault installed and are signed in, the Report Maker option will now allow you to 

Copy Out, Check Out, Check In and Uncheck Report Maker format Files. 

Format Files folder and combo boxes can now handle Vault virtual folders and format files stored in 

the Vault. 
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New commands to Report Vault Status 

Report Maker has two new commands for reporting the vault status: 

List of Vault Statuses -  allows you to report all the Vault statuses that can be applied to items in the 

Vault. The command is available in Vault and Design contexts. Within this command, you can report 

the Status Name and its Value. The Value represents the Status position compared to other statuses 

in the Vault Status list. 

Vault Status – allows you to report the Vault Status of a Vault item. This command is available for 

List of Vault Items. If the Vault item has a status, then the status name is reported, otherwise it will 

report nothing. 

 

Design Rules Check and Electrical Rules Check command - Named Rule Sets 

A named rule set list box has been added to the Design Rules Check and Electrical Rules Check 

commands. This will list any existing named rules found in the design.  

 

The default named rule set, <acceptance rule set> is used if you do no specify your own rule set. 

New commands to support Material Parameters 

New commands have been added to support the Material parameters defined in the Technology and 

Materials page. 

List of Materials command will report all fields for a Material. 
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Under the List of Layers command, you can report the Material Density and Material Special Use 

fields. 

 

New command for List of Layers on Pin List with new ‘Pin Attached To’ field 

When using the List Of Pins command, you can now go through a list of electrical layers from within 

the pin list using the List of Layers command. 

 

There is also a new field command Pin Attached To which will return the item the current pin is 

attached to on the current layer if it is attached on that layer. This new field command is only 

available from within a layer list if the parent of the layer list is a pin list at some point.  

This feature was back-fitted to V13.0. 

New command option to stop adding a space at the end of a column 

In commands that report fields in a column now have an extra check box on their edit dialog - No 

Space Separator At End. When selected, this will stop automatically outputting a space between 

columns even if the Column Width is set to zero (0). 
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Major Update to Scripting – Support for Python 3.8  

There is a new scripting interface to Pulsonix based on in-house technology. It is separate from 

ActiveX scripting and the API built on it, but can be used similarly to it using Python 3.  

Currently, this will run along side the existing ActiveX scripting mechanism, but in time will 

supersede it. 

The existing scripting mechanism has been renamed on the menu to Run Script (Legacy) and the 

new scripting mechanism will be call Manage Scripting. 

 

 

Existing Scripts 

If you have scripts that have been created in the existing mechanism, they can still be used, or you can 

convert them to use the new mechanism. There are a few procedures to do to enable this: 

- Install Python 3.10 or above 

- We recommend you copy your existing script to another file as a backup before converting it. The 

file will be edited to accommodate the new scripting commands and will not be able to be run in 

the old mechanism once converted. 

- You will now edit the existing script or its copy into the Python coding environment. 

- Existing commands will need to be converted. The Python editor will highlight unsupported 

commands. 

- Using the new environment and the new command structure is described in detail in the online 

help supplied with Pulsonix. 

New Scripts using the Manage Script option 

To use the new scripting mechanism and Manage Scripting option, you must have Python 3.10 or 

later installed first. 

Once the Python environment is installed, the Manage Scripting option on the Tools menu opens the 

Scripting Dashboard from where the scripts can be controlled. 
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Scripts will be created within the Python environment. 

Detailed information about using the new environment and the new command structure is described 

in the online help supplied with Pulsonix. 

Using Python 3 scripts on another PC 

If you create a script in Python 3.x that a colleague will also want to use, they must also have Python 

3.10 or later installed on their machine. 

Features included for the new Scripting Mechanism in V14 

Below is a non-exhaustive list of features that have been added to the new scripting system and not 

available in the legacy system, (class names are shown in italics): 

 

- Provided official Python 3.10+ support with the option to add support for other languages. 

- Added DesignShape which provides access to line styles and filled status. 

- Added functions on Document to create and delete line, pad and text styles. 

- Added additional functions to Material. 

- Added the ability to get Board types and names. 

- Added more practical examples. 

- Added the ability to get the Symbol of a SymbolInstance 

- Added the ability to tell if a CommonShape is closed. 

- Improved the interface to Areas. 

- Improved the interface to Folders settings. 

- Improved the interface to part and symbol libraries. 

- Added the PredefinedShape class which is inherited by PadStyle and PadStyleException. 

- Added new types of PadStyles 
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Scripting Pad Styles (Legacy Scripting) – New Objects - Plated and ForUseBy 

Pad Style objects in scripting now have a Plated property, allowing you to get and set whether a pad 

style is plated (or not). 

The ForUseBy method on a Pad Style object can now set and get the Use By state for the Through 

Mounting Hole and Surface Mounting Hole pad types. 

This feature was back-fitted to V13.0 to the legacy scripting feature. 

Pulsonix Sim – Spice Simulator 

Using PulsonixSim 

The PulsonixSim option is based on the NG Spice engine. This is a cost option and a new licence is 

required for this option.  

A reference is provided to the NGSpice Users Guide on our web site:  

https://pulsonix.com/downloads/manuals/14.0/ngspice-44-manual.pdf  

A link to this manual is also available under Help> Online Manuals> within Pulsonix itself. 

Choosing the PulsonixSim Simulator 

This simulator is enabled by selecting PulsonixSim as the Spice Netlist Type. 

 

When switching to the PulsonixSim simulator, the Simulation menu changes to reflect this Spice 

functionality. The LTSpice.pal and Spice.pal Parts libraries will automatically be disabled for you 

on this mode selection. 

A note about the switches for choosing LTSpice and PSpice compatibility, the default setting for 

PulsonixSim is for both to be defined, meaning that PulsonixSim is compatible with Spice modes 

defined for both simulator sources. 

Libraries 

PulsonixSim is supplied with its own Parts library called PulsonixSim 

You should disable both the LTSpice.pal and Spice.pal Parts libraries under Setup Folders and 

Libraries so that these are not accidentally used. 
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The PulsonixSim.pal Parts library has been created to accommodate the nuances of the PulsonixSim 

simulator. 

New Simulation Menu 

The Simulation menu adjusts the contents depending on the Spice Type defined. 

For PulsonixSim, the menu now looks like this: 

 

The Parts toolbar is not available with PulsonixSim. However, related Parts, Sources, Probes and 

other design items are available on the simulation menu as their own sub-menus. 

There is also a Simulation toolbar to use. This has commonly used PulsonixSim commands. 

 

Using the Simulation Files sub-menu, you can view the circuit Netlist, the Log file of results when 

the simulator was run, including error reporting, warnings and general info on the simulation.  

 

The Output driver file is the file used to tell the simulator what to do to the circuit.  

Selecting any of these will display in your default text editor. 

Adding Graphs into the design 

The new simulator has full window graph capabilities and also local in-design Inserted Graphs. 
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Adding an Inserted Graph 

Add an Inserted Graph by selecting Inserted Graph from the Simulation> menu and Probes> . This 

option is also available on the Insert menu. A graph probe will be on the end of your cursor ready for 

positioning. Select a net to attached it to. Once attached, the graph window will now be available for 

positioning in your design. Once released, the graph will display simulation results. If no existing 

simulation results are available, run the simulator by pressing F9. 

If you wish to use a full graph window to display the results, add Probes to the design. 

To remove a graph window from the design, simply delete it using the Delete key. 

Changing the Inserted Graph Probe 

The probe used to attached the Inserted Graph to the connection is a Part named Graph Probe. This 

uses its own symbol and can be changed by you. The supplied Schematic symbol for this Part is 

GProbe. 

 

Noe: If the Graph Probe component is not available, the Inserted Graph option will look for the 

Voltage Probe Part in the library. 
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Default Design Setting Properties of an Inserted Graph 

You can set basic default settings of an inserted graph window from the Settings menu> Design 

Settings> Defaults> Inserted Graph page: 

 

Properties of an Inserted Graph  

When an Inserted Graph has been inserted into the design, you can use Properties to change the 

graph shape line style and size, and the pointer line position. You can also change the Line Style, 

attachment location and its own colour: 

 

Resizing an Inserted Graph 

The Inserted Graph outline shape works the same as a regular shape. If you drag one side of the 

outline to resize it, when you release the mouse the shape releases. This way, you can make the 

window as big or small as required. 

Moving an Inserted Graph 

Pick on the framework around the graph but not the shape outline. Selecting the shape outline will 

edit the shape. 

Graph Tooltip 

If you click in the Inserted Graph a tooltip will be displayed. This shows you the net name, Time and 

Voltage at the point of the line. 
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Graph Labels 

If you select the labels within the graph windows, you get context dialogs that can be used to edit 

information within them. 

 

Title, Net Name, Time 

Selecting the text of these labels displays a small dialog from where each label can be edited:  

 

Graph Series 

Selecting the bar or text to the right of the graph displays a small dialog from where the colour and 

display of signals can be defined:  
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Context menu options for an Inserted Graph 

If you select one side of the Inserted Graph, you will see the ‘shape’ context menu and options related 

to shapes. 

If you select the whole Inserted Graph shape or inside the shape on the graph, you can right click and 

select options from the context menu: 

Export Sim Graph – export the graph to a bitmap format file. 

Convert to Graph Window – converts from an in-design graph to a full graph window. This 

closes the Inserted Graph and opens a full graph window. It replaces the Inserted Graph probe 

with a graph probe. 

Open Graph Window – switches and duplicates an in-design graph to a full graph window. 

Changing the Colour of Graph Windows 

Colours for aspects of Inserted Graph can be changed within the Colours dialog and Graphs page. 

 

Combining Inserted Graphs 

If you wish to overlay two or more signals into one Inserted Graph, drag an Inserted Graph over 

another one; the one you wish to combine it into. Click the 'host' graph to complete the combining. 

You will now see two (or more) lines directing from the originating nets. 
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The styling of the leader lines from the Inserted Graph shape will be the same now and defined in the 

shape Properties. 

 

Closing a Full Graph Window 

If running multiple full graph windows, you can close the graph(s) by right clicking on the master 

schematic workbook tab and selecting Close Graph Windows. 

 

Random Probing 

Once simulation has been run, you can choose to Random Probe from the Simulation menu: 
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Once selected, a Random Probe cursor is displayed: 

 

Once a Random Probe has been selected, you can right click and from the context menu, select the 

type of probe to use: 
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As you probe, a full graph window will be drawn. These are transient and not saved with the design 

and no ‘probe’ is inserted into the design. Effectively, these act the same way as if you probed a real 

design using a scope; you get the results at that moment. Each net probed will be displayed in the 

graph and updated with the next one probed. 

Bias Annotation 

You can insert Bias Annotation markers into your design when running a DC Operating Point 

(DCOP) analysis: 

 

From the Simulation> menu, select Bias Annotation> select Insert Voltage or Current Marker to 

add markers selectively, or Autoplace Markers to place through out the design. 

 

If using Autoplace Markers it will place Voltage Markers in the design. 
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Library Manager - SPICE Models Page 

If you have the Pulsonix Sim Spice simulator licence, there are new Spice Model Folder and Spice 

Models pages available in the Library Manager from where you can edit and manage your Spice 

Models. 

To see these pages in the Library Manager, you must also have your Spice Netlist Type set to 

PulsonixSim from the Simulator menu and Set Netlist Spice Type. 

 

The Spice Models Folder page is a standard folder selection/management page, the same used for 

STEP Models and Library Folders. 

The Spice Models page is used to manage your models allowing you to view and edit them. 
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Spice Value 

The PulsonixSim engine uses the <Spice Value> attribute. For components using this, select the 

component and press F7 (Edit Spice Value). 

 

Running PulsonixSim 

Run the simulator by pressing F9 or from the Simulation menu, Simulate Design. 

Associated Simulation Files 

Following a simulation run, a number of additional files are created and saved along side the design 

file. If you wish to move the design to another machine, and retain the simulation results, you should 

also move these files: 

.cir - the Spice netlist of the design. 

.out – the simulation results that are read by PulsonixSim to create the graph windows. 

.log – this is a log of the last simulation run. This contains any errors or warnings produced when the 

last simulation has been run. This is not a critical file for simulation and is purely used for refence. It 

is not required if you move the design file. 

.sch – this is the actual Pulsonix schematic design. 

Note: the Netlist, Output file and Log file can be viewed using the Simulation Files sub-menu from 

the main Simulation menu. 

  


